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2.0 System Summary

1.0 GENERAL INFORMATION

1.1 System Overview

Cardiopulmonary resuscitation (CPR) is a procedure used with unconscious victims of some type
of trauma which has caused the heart to stop beating in order to simulate a functional heartbeat and
oxygen intake through breathing. Currently, CPR training is usually performed using a mannequin and
supervised by an instructor. We improve the quality of the training process to perform CPR creating a
tool to facilitate the job of the instructors by electronically monitoring students practicing CPR on a
training mannequin. Our product consist of a mannequin that will be monitored using different sensors
and a software application which retrieve and process the information in order to provide proper training
and support the instructor. The mannequin simulates a person who needs CPR and responds to the steps
if they were applied according to the rules of the CPR manual or instructor. The trainer use software
installed in a normal computer to control the mannequin’s actions and obtain results of his or her students
in real time, with the ability to save the data or retrieve previous session data from a database.
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1.2 Project References

[1] Thygerson, A. (2005). First aid, CPR, and AED, 4" ed. Jones and Bartlett: Sudbury,
Massachusettes.

[2] National Safety Council. (1999). Heartsaver facts: First aid, AED, CPR training system.
Jones and Bartlett.

[3] National Safety Council. (1997). CPR for the professional rescuer. Jones and Bartlett.
[4] Jones, A. (2003). C# for Java developers. Microsoft Press.

[5] Microsoft Corporation. (2002). Microsoft visual C# .NET: Language reference.
Microsoft Press: Redmond, WA.

[6] Obviex. (2009). How to: Encrypt and decrypt data using a symmetric (Rijndael) Key
(C#/VB.NET). Retrieved February 10, 2009 from
http://www.obviex.com/samples/Encryption.aspx#

1.3 Authorized Use Permission

Only the people that acquired the system through our company and agree with the following
terms are authorized to utilize it:

“This product in no way, shape, or form intends on replacing conventional, professional teaching
of CPR procedures. Its only intention is the facilitation of teaching and evaluating CPR students. Proper
use of the product does not imply that the user will be certified to give CPR.

It falls under the responsibility of the instructor to take into consideration the legal aspects
concerning CPR instruction and performing CPR.”

1.4 Points of Contact

1.4.1 Information

Engineering Health Solutions is a group that intends to bring solutions to problems that involves
the health and safety. We spec to solve issues that can do the difference in the life of many people.

1.4.2 Help Desk

For emergency assistance please contact EHS by this email: engineering.health.solutions@gmail.com.
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1.5 Organization of the Manual

Provide a list of the major sections of the User’s Manual (1.0, 2.0, 3.0, etc.) and a brief description of
what is contained in each section.

1.6 Acronyms and Abbreviations

CPR eTAM — CPR Electronic Teaching Assistant Mannequin
EHS — Engineering Health Solutions
CPR eTAM app - CPR eTAM software
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2.0 SYSTEM SUMMARY

CPReTAM is a mannequin monitored and controlled by sensors, a microprocessor, and computer
software in a personal computer to simulate the steps performed in a CPR rescue session. This tool
facilitates the job of the instructors by electronically monitoring students practicing CPR on a training
mannequin. We provide the hardware and software to identify when a student is not following the
correct procedure; monitoring chest compressions, the victims breathing and pulse, and the position of
the victim's head using specialized software to configure the mannequin and display the data provided
from the real time situation in the mannequin.

The CPR eTAM app can be divided into three principal modules: How To, Training and Setting.
Between all those modules, it allows the user to create an account, manage student information, run
training sessions to evaluate and train students, and store results of those sessions. The user is able to
change the evaluation metrics used in the program to evaluate the student at the training session.

In order for the system to perform everything mentioned above, you need to have a 120VAC wall

plug, 4xAA batteries, and a computer with a usb port connector.

2.1 System Configuration

Briefly describe and depict graphically the equipment, communications, and networks used by the
system. Include the type of computer input and output devices.

You need to assemble some parts of the system before use it. Here are pictures of the steps that show you
how to mount the system.

(1) Put the head of the mannequin in the torso
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(2) Support the head in the torso with the lock.

(3) Connect the cable of the head in the port of the torso.
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(4) Turn around the mannequin and connect the cable of the blue box in the blue port.
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(5) Connect the green cable of the head to the green port.

(6) Connect the blue box to a switch.
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(7) Turn on the blue box.

2.2 Data Flows
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2.0 System Summary

The system can be divided into two main modules, hardware and software. The hardware module
has a one-way communication from the sensor and devices to the micro-controller. At the software
module exists two way communications between the Graphical User Interfaces class, the Main class,
user and the database. The communication in the software module indicates the interaction between
the user and the application. The user could be inputting student information on the system, and when
the user is done, the system will provide a feedback form to the user, indicating the status of the
request of the user. There is a two-way communication between both modules. This design was
implemented for the hardware module to send information about the sensors to the application, while
the application indicates the micro-controller when a training session is started and when a training

session ended.

User’s Manual Page 2-6



2.0 System Summary

8051 Micro-
controller

Hardware communication

Zigbee
Module

Software communication

Zigbee
module

Interaction

Communication

USBConnector
.cls

Data

DBConnector.

Main.cls
cls
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2.0 System Summary

2.3 User Access Levels

The system currently allows two types of users: unlogged and logged users. The unlogged user
have access to the “How to”, “Training”, and “Settings” of the application, while the logged user has
access to those and is able to add/delete student, course, and section information and to store training

session results.

2.4 Contingencies and Alternate Modes of Operation

The system has been developed to detect and correct some errors. At the hardware module, if a
connection is disconnected at the sensors, the status Light Emitting Diode (green) on the bottom of the
mannequin will turn off. If there is a problem with the micro-controller power, the Light Emitting Diode
(red) at the box. At the software module, we are utilizing “try-catch statements” which ensure the
continuity of the application. If an instruction fails, the statements shows a window indicating an error

message that will allow the developers to find and correct the error displayed.
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3.0 GETTING STARTED

This section provides a general flow walkthrough of the system from initiation through
the exit.

3.1 Logging On
To logging on the system you must double click the CPReTAM application. When you are in the

principal frame, click file and then log on into the system.

CPR e-TAM
Fle Edit Help

Username: |

Password: |
Create a new account

Forgot your password?

Logged on: Mo Log on to access all features.

3.2 System Menu

This section describes the system menu first encountered by the user, as well as the
navigation paths to functions noted on the screen.
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3.2.1 View my account info

Log on - File > Account > View my account info

AccountInfo

Full name: frank mendoza

Username: |mendoza

New Password: |

Confirm password: |

Secret question:  |asdf

Answer: |ou.

Apply I Delete account I Cancel |

3.2.2 Create a course

Log on - File = Account ->Create a course

CPR e-T&M
Fle Edit Help

oY !
| Cowrse code: II—
T Course number: [ i&;; o
Course section: l_ '

Section capacity: I

Cancel |

M

Logged on: Yes
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3.2.3 Add a section to a course

Log on = File - Account > Add a section to a course

CPR e-TAM
Fle  Edit

Help

q Select a cowrse: |_ vl
Section number: |
Amount of students: |

Logqedon Yes

3.2.4 Add students

Log on - File - Account ->Add students

CPR e-TAM
Fle Edt Help b

o T Tntm'ials:-::lntel'activé%ﬁ?hs for effectivelv

Add students

Select a course: I 'I Section number: l vl

Add a student individually:
Student’'s name Student’s number

| | |

or

Y

Add a student list from a csv file: I
What is a csv file? .
Browse csv file J Add student list |

| Done I Cancel I

More Invlf ‘ i
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3.2.5 Delete course

Log on = File > Account - Delete course

CPR e-T&M

File  Edit

Help

: i
More In : : ‘,

0
Tr e —"ﬁ L
Select a comrse: |_j' ;

I Delete I Cancel |
Info

3.2.6 Delete students

Log on > File > Account - Delete students

CPR e-TAM
File Edit Help

R D o le e students

Select a course: |_ 'vl Section number: | '“

Select the student | | Delete I

Cancel I

1is program to your il
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3.2.7 Delete sections

Log on = File = Account - Delete sections

ICPR e-TAM

=

Fle Edt Help
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3.2.8 Test USB data transfer

Log on > Back button > Edit > Test USB

CPR e-TAM

File Edit Help
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3.2.9 Tutorials

Select Tutorial Icon (First icon at main screen).
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3.2.9.1 How to Perform CPR

Tutorial->Perform CPR (first icon at tutorial screen)

How to perform CPR ==

i\’Velcome to the tutorial for performing CPR.

DISCLAIMER: Before we get started, please keep in mind
that this tutorial does not intend to replace formal CPR.
training. Completing this tutorial does not mean that you
are certified to perform this procedure, but will help in
obtaining a certification. In the probable case that you are a
CPR instructor, the purpose of this tutonial 1s to see how the
program will determine whether or not a student is
performing the steps correctly.

Images courtesy of the Association of First Aiders (AoFA).
For more information please vistt www AoF4 org

To continue on to the next part of the tutorial, click Next. If
you need to go back for some reason, click Back. If at any
tine you wish to quit the tutorial and return to the main page,
click Quit. Now that we have that out of the way, let's begin!

What is interactive mode?

Quit | Previous Next

Interactive mode: OFf
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3.0 Getting Started

How to perform CPR B

Welcome to the tutorial for performing CPR.

DISCLAIMER: Before we get started, please keep in mind
that this tutorial does not intend to replace formal CPR.
training. Completing this tutorial dees not mean that you
are certified to perform this procedure, but will help in
obtaining a certification. In the probable case that you are a
CPR instructor, the purpose of this tutorial 1s to see how the
program will determine whether or not a student is
performing the steps correctly.

Images courtesy of the Association of First Aiders (AoFA4).
For more information please wistt www. AoF4 org

To continue on to the next part of the tuto

Feu need t‘? go bacllc for SOME.Thasom, clic \ ? ) wWould you like to enable the interactive version?
time you wish to quit the tutorial and retur

click Quit. Now that we have that out of t
Yes Mo |

What is interactive mode?

Quit I Previous | I Next I

Interactive mode: Off

User’s Manual Page 3-9
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3.2.9.2 How to Add Courses

Tutorial->Add Courses/Students (second icon at tutorial screen).

3
- -
Tutorial for adding courses ‘ ;

& students

Tutorials: Intera
program.

The first step in adding a course and
students 1s to log into your account. Of
course if you don't have an account you
will need to create one. The steps for

creating an account are fairly Quit More Info
straightforward, and therefore not

covered in this tutorial Training: The
- . g r g “7-:_’ e, 2 é_.

To log in, simply click the File menu
strip item, and select Log in. A new L
windows wil pop vp, s for your | cr—
username and password. Enter them
into the appropnate field, and select Username: [mendoza
Ok. If you entered the information Password: [sees|
cotrectly, the program goes back to the
main window, and the status strip
should read "Logged on: Yes".

w
o
<
(4]
-

Open... ° >

LN

Create a new account

Forgot your password?

Foc ] o |

Quit Previous Next I Settings: Configur e this program t
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3.2.9.3 View past results tutorial.

Tutorial->View Past Results (third icon at tutorial screen).

Begin Training

-

Create a detailed report ]

Course Section
{100
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3.2.10 Training
If you are logon you can see the information described below.

3.2.10.1 View/edit course

Training—> View/Edit courses (One icon at training screen).

I3

Student information

Student name: ‘

View/E dit Courses

) Students
Ntident nurtlies Courses Juanma Feliciano
|'I 23-45-67890 A Magic Johnson
‘ EDFI 8335 Frank Sinatra
. Jery Seinfeld
Avell‘age grade: ‘ __' George Costanza
0 o M
| Cosmao Kramer
Course Name: ; Sections
IEDFl Section: =]

Course Number: |1gg vl
|3B45

How do | edit or delete a student?
Apply | Cancel | \

Delete I . .

=l

Create course Create section

Back l Detailed Information

User’s Manual Page 3-12
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3.2.10.2 Begin a training session
Training—>Begin a training session (second icon at training screen).

Live Training - Instructor: frank mendoza

o : = . Course Section
Grt‘agibled C Disabled &Ff)c?es eorisess x| fioo ]
. . & 1 Student
—Grading Profile an
& Default G2
C  Custom | 48

Session Information

Elapsedtime: pp-00:00
thh:mm:ss)

" Live Preview

" Enabled  Disabled

Save results?
( ® Yes € No

START

Back I Prev. Step

STOP
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3.0 Getting Started

3.2.11 Settings

Select Settings (Third icon at main screen).

CPR e-TAM

File Settings

~Default grading scheme
Points to deduct: (for missed st

Shout at victim:
Head-tilt:

Nose pinch:

| I

Rescue breaths:

Pulse check:
Compressions:  2ea

~Advanced options

COM Port A
(for wireless comm)

Current pott:

3.3 Changing Password

To change the password you must press the logon button and click the Forgot your password? option and
enter your username. In the next frame you must answer your secret question, enter a new password, and
confirm it. Now your password is change.

3.4 Exit System

To exit the system you must find out the way to see the exit red X pressing back or quit button. It
depends on the frame you are.
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4.0 REPORTING

4.1 Report Capabilities

The application is able to create a report of the session realized by a student. The report starts
with a table that shows the last 5 grades of the student within a section of a course. That table also shows
the average grade of the student. If you select a student, by clicking over his/her name, you can see the
passing grade expected by the evaluator, the grade obtained by the student and where the student failed.

Table summary:

F
@@B Evaluation report for
Gc@Am EDFI 3645 - 070

Below is the evaluation summary for the specified section. To view a detailed report of a
particular student, click his or her name.

Student name Student number Sesslon grades

Avg 1 2 3 4 5
Juanma Feliciano 802-03-1061 N/A N/A N/A N/A N/A N/A
Magic Johnson 555-55-5555 N/A N/A N/A N/A N/A N/A
Frank Sinatra 569-22-3265 N/A N/A N/A N/A N/A N/A
Jerry Seinfeld 456-03-4568 79 100 96 100 20 N/A
George Costanza 456-40-5879 N/A N/A N/A N/A N/A N/A
Elaine Benes 123-45-6789 N/A N/A N/A N/A N/A N/A
Cosmo Kramer 987-65-4321 N/A N/A N/A N/A N/A N/A
Click on a student’s name to jump to his or her detailed report.

Juanma Feliciano packtotop

No procedures performed yet!
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Results:

Session number 2
Grade 32/100
Passing grade for this 80/100

session

First cycle

Consciousness

check

Head-tilt,

chin-lift

Nose pinch

First rescue

breath
Second

rescue breath |

Pulse check

Chest

compressions

Head-tilt,

chin-lift

Nose pinch

First rescue

breath
Second

racrna hraath

e

=
N

X[ 5¢ 3¢ 3¢ 3¢

Second cyde

Head-tilt,
chin-lift

Nose pinch

First rescue

breath

Second
rescue
breath

Chest

compressions

Head-tilt,
chin-lift

Nose pinch

First rescue

breath

Second
rescue
breath

A S S

Third cyde

Head-tilt,
chin-lift

Nose pinch

First rescue

breath

Second
rescue
breath

Chest

compressions

Head-tilt,

chin-lift

Nose pinch

First rescue

breath

Second

rescue
breath

(IR [ B [ B 3¢
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